
   
 
 

Programovatelný robot ARDUINO AREXX AAR-04 
 
 
 
 
 
Obj. č.: 19 16 94 
 
 
 
 
 
 
 
 
Vážení zákazníci, 
 
děkujeme Vám za Vaši důvěru a za nákup programovatelného robota ARDUINO ARREX AAR-04. 
 
Tento návod k obsluze je součástí výrobku. Obsahuje důležité pokyny k uvedení výrobku          
do provozu a k jeho obsluze. Jestliže výrobek předáte jiným osobám, dbejte na to, abyste     
jim odevzdali i tento návod.  
 
Ponechejte si tento návod, abyste si jej mohli znovu kdykoliv přečíst! 
 
Stránky technické pomoci: www.arexx.com a www.roboternetz.de 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Popis výrobku AAR 
 
Rodina robot ů ARDUINO 
 
Arduino je volně dostupná platforma pro vývoj elektronických prototypů, která zahrnuje mikro 
kontrolér, všechny periferní rozhraní a požadovaný software. 
Koncept Arduino byl navržen tak, aby vám nejjednodušším možným způsobem pomohl pochopit 
moderní elektroniku robotů, senzory a jejich ovládací software. 
AREXX Arduino přichází jako nástupce robota ASURO, který se programuje v jazyce C. Nový robot 
připomíná svého předchůdce ASURO, ale v kombinaci s volně dostupným programovacím jazykem je 
programování systému Arduino mnohem snadnější. 
 

Rozsah dodávky 
 
Robot Arduino AAR-004 
USB programovací kabel 
CD-ROM, který obsahuje všechen požadovaný software a ukázkové programy 
Návod k použití 
 

Bezpečnostní pokyny 
 
UPOZORNĚNÍ 
 
1. Pozor!  Tento návod si musíte přečíst ještě předtím, než jakoukoli část robota připojíte k napájení! 

Špatná připojení mohou poškodit hardware. 
2. Pozor!  Pečlivě si zkontrolujte schéma vývodů a při propojování obvodu buďte opatrní. Špatná 

připojení mohou poškodit moduly. Dodržujte správnou polaritu napájení. Obrácená polarita může 
poškodit hardware. 

3. Pozor!  Nepoužívejte napájecí zdroj, jehož napětí je mimo určený rozsah! Používejte stabilizované 
a filtrované zdroje. Abyste se vyhnuli špičkám. 

4. Pozor!  Základní deska není nijak chráněna proti vodě a prachu. Systém proto používejte                      
a uchovávejte jen v suchém prostředí. 

5. Pozor!  Dávejte pozor, aby nedošlo ke zkratu na kovovém povrchu a desku plošných spojů ani 
konektory nevystavujte příliš velké síle nebo váze. 

6. Pozor!  Dávejte pozor, aby nedocházelo k elektrostatickým výbojům (viz preventivní                            
a bezpečnostní a popis pod heslem "Elektrostatický výboj" ve Wikipedii). 

 
Obecn ě bezpečnostní pokyny 
• Právo na vrácení výrobku ztrácíte po otevření plastových sáčků obsahujících jednotlivé části                

a komponenty. 
• Pozorně si přečtěte tento návod ještě předtím, než začnete robota skládat. 
• Při manipulaci s nástroji zachovávejte opatrnost. 
• Výrobek udržujte mimo dosah dětí. Neskládejte robota v přítomnosti malých dětí. Mohly by                

se poranit nástroji, nebo spolknout malé části a komponenty. 
• Zkontrolujte správnou polaritu baterií. 
• Dávejte pozor, aby byly baterie stále suché. Pokud se Arduino namočí, vyjměte baterie a všechny 

části co nejlépe vysušte. 
• Když nebudete robota delší čas používat, vyjměte z něj baterie. 
 
Kdo, nebo co je ARDUINO? 
 
Arduino je jednočipový počítač s volně dostupným zdrojovým kódem, který umožňuje jednoduchý 
přístup k programování, integrovaným obvodům a k projektovým platformám pro kumštýře, 
konstruktéry a jiné nadšence. 
Platforma Arduino je založena na mikropočítači Atmel ATmega168 nebo Atmega328. Systém nabízí 
uživatelům digitální porty I/O a analogové vstupní kanály, které umožňují, aby systém Arduino přijímal 
a reagoval na signály z okolí. 



Na trhu je k dostání několik desek Arduino, jako např. Arduino Uno, Arduino LilyPad a Arduino Mega 
2560. Každá z těchto desek je navržena k určitému účelu a uživatel si tak může vybrat ideální sadu 
pro téměř každý projekt. 
Například vstupní signály lze přijímat z přepínačů, světelných senzorů, senzorů rychlosti a zrychlení, 
nebo ze senzorů teploty a kolizních senzorů. Mimo to je možné přijímat příkazy i z jakéhokoli zdroje na 
webu. Výstupní signály se využívají k ovládání motorů, čerpadel a obrazovek displejů. 
Součástí systému je kompilátor pro standardizovaný programovací jazyk a bootloader. Programovací 
jazyk vychází z Wiring a koresponduje s jazykem C++. 
Projekt Arduino vznikl původně v roce 2005 ve městě Ivrea v Itálii. Jeho cílem bylo podpořit studenty 
vytvořit pro ně jednoduchou prototypovou platformu, která by byla levnější a efektivnější než většina 
standardních metod. Skupina vývojářů pod vedením Massimo Banziho a Davida Cuartiellesa se 
rozhodla pojmenovat projekt po významné historické postavě města Arduinovi z Ivrea. Arduino je 
italská verze jména, která znamená "silný přítel". 
 
Jedno čipové po čítače! 
 
Použití 
Jednočipový počítač (nebo také angl. mikrokontrolér označován zkratkou µC, uC nebo MCU) je malý 
počítač s jedním integrovaným obvodem, který obsahuje jádro procesoru, paměť a programovatelné 
vstupní a výstupní periférie. Čip často obsahuje také paměť pro uložení programu a malou datovou 
paměť (RAM). 
Jednočipové počítače se používají v automaticky řízených výrobcích a zařízeních, jako jsou ovládací 
systémy automobilových motorů, implantovatelné zdravotnické přístroje, dálkové ovladače, 
kancelářské stroje, spotřebiče, elektrické nářadí a hračky. Svými malými rozměry a nízkou cenou                 
v porovnání s počítači, které používají samostatný mikroprocesor, paměť a vstupní/výstupní zařízení, 
představují jednočipové počítače ekonomické řešení pro digitální ovládání i většího počtu zařízení             
a procesů. 
Je běžné, že typická rodina v rozvinutých zemích má dnes doma čtyři univerzální mikroprocesory a tři 
tucty jednočipových počítačů. Typický automobil střední třídy má až 30 nebo i více jednočipových 
počítačů. Můžete je najít rovněž v mnoha elektrických zařízeních, jako jsou pračky, mikrovlnní trouby   
a telefony. 
 
Spot řeba energie a rychlost 
Některé mikrokontroléry pracují na velmi nízké taktovací frekvenci až 4 kHz, aby se zachovala nízká 
spotřeba (několik miliwatt, nebo mikrowatt). Mají schopnost udržet si funkčnost a čekat na akci, jako je 
stisknutí tlačítka, nebo jiné vyrušení z nečinnosti; jejich spotřeba proudu během spánku (většina 
periferií a hodiny CPU jsou vypnuty) může být jen několik nanowatt, takže se většina z nich dobře hodí 
k aplikacím na baterie s dlouhou výdrží. Jiné jednočipové počítače mohou plnit roli v procesech 
náročných na výkon, kde mohou působit spíše jako digitální signálové procesory (DSP) s vysokou 
taktovací rychlostí a velkou spotřebou proudu. 
Systém Arduino využívá výkonný čip Atmel ATmega328P s 8 bitovým mikro kontrolérem při 16 MHz            
a s 32 kB systémové programovací flash paměti. Napájecí napětí je celkem univerzální s rozsahem             
7 - 12 V DC, což vytváří stabilizované a bezpečné provozní podmínky čipu a izolovaných vodičů až do 
2 A na obvodu motoru. 
 
Programy jedno čipového po čítače 
Programy mikrokontroléru musí svou velikostí odpovídat dostupné programové paměti na čipu, 
protože vybavit systém externí rozšiřovací pamětí by byla drahá záležitost. K převodu kódů 
vysokoúrovňového jazyka a assembleru (jazyka symbolických instrukcí) na kompaktní strojový kód, 
který se ukládá do paměti mikrokontroléru, slouží kompilátory a assemblery. V závislosti na zařízení 
může být programová paměť trvalá, jen pro čtení (ROM), která se může programovat jen ve výrobě, 
nebo to může být programovatelná Flash paměť, nebo mazatelná ROM paměť. 
Mikrokontroléry byly původně programovány jen v jazyce symbolických instrukcí, ale dnes je celkem 
běžné používat pro ně i různé vysokoúrovňové jazyky. Tyto jazyky jsou buď určeny speciálně k tomuto 
účelu, nebo se jedná o různé verze univerzálních jazyků, jako je programovací jazyk C. Prodejci 
mikrokontrolérů často poskytují nástroje bezplatně, aby bylo možné jejich hardware snadněji 
přizpůsobit. 
Systém Arduino nám nabízí přibližně 32 kB flash paměti pro programy, které lze psát                                 
v programovacím jazyce C. 
 

Architektura rozhraní 
Mikrokontroléry obvykle obsahují několik nebo až celé tucty víceúčelových I/O vývodů, resp. pinů 
(angl. zkratka GPIO). Vývody GPIO se pomocí softwaru nastaví buď jako vstup, nebo jako výstup. 
Pokud se GPIO vývod nastaví na vstup, slouží obvykle pro čtení senzorů, nebo externích signálů.             
Při konfiguraci na výstup mohou GPIO vývody řídit externí zařízení, jako jsou LED, nebo motory. 
Mnoho vestavěných systémů potřebuje číst senzory, které vydávají analogové signály. Využívají                
k tomu převodníky analogového signálu na digitální signál (ADC). Protože procesory jsou 
konstruovány tak, aby interpretovali a zpracovávali digitální data, tj. jedničky a nuly, nedokážou udělat 
nic s analogovými signály, které jim může posílat nějaké zařízení. Proto se k převodu příchozích dat 
na formát, který dokáže procesor rozpoznat, používají převodníky analogového signálu na digitální 
signál. 
Méně obvyklou výbavou některých mikrokontrolérů je převodník digitálního signálu na analogový 
signál (DAC), který umožňuje procesoru vysílat analogové signály úrovně napětí. 
Kromě konvertorů obsahuje mnoho vestavěných mikroprocesorů také různé časovače. Jedním                 
z nejobvyklejších typů je programovatelný intervalový časovač (PIT), který slouží k odečtu od určité 
hodnoty na nulu. Když dosáhne nulu, odešle na procesor mezeru, čímž signalizuje, že ukončil 
odpočet. Je to užitečné např. v případě zařízení, jako jsou termostaty, které v pravidelných intervalech 
kontrolují teplotu prostředí, aby rozpoznaly, kdy je potřebné zapnout klimatizaci, nebo topení, atd. 
Přijímat a vysílat data pro sériovou komunikaci s malým zatížením CPU, umožňuje blok UART 
(univerzální asynchronní přijímač/vysílač). Tento kousek hardwaru na čipu disponuje i možností 
komunikovat s jinými zařízeními (čipy) v digitálních formátech, jako je I2C a sériové periferní rozhraní 
(SPI). 
Systém Arduino nabízí 14 digitálních I/O vývodů a 7 analogových I/O vývodů. 
 

ROBOT AREXX ARDUINO 
 

 
Obr. 1: Deska plošných spoj ů AAR  
 
 
 
 
 
 
 
 
 



Blokové schéma robota Arduino 
1. Konektor pro připojení baterie. (Dávejte pozor na správnou polaritu!) 
2. Přepínač zapnutí a vypnutí robota. 
3. LED kontrolka stavu: signalizuje, že robot je napájen zdrojem. 
4. V případě, že používáte nabíjecí akumulátory, můžete použít tento duální konektor, přes který             

se bude robot napájet správným napětím. 
5. USB konektor pro programování robota pomocí softwaru Arduino. 
6. Resetovací tlačítko, které se použije pro manuální resetování robota. 
7. Konektor ISP, který umožňuje instalovat další program bootloader. 
8. LED 14: umožňuje přístup k programování a bliká, když se aktivuje bootloader. 
9. Sledovač čáry: Tento modul poskytuje přístup k programování a umožňuje, aby robot sledoval 

čáry. 
10. Senzor levého kola: modul, který generuje pulzy v souladu s otáčkami levého kola. 
11. Senzor pravého kola: modul, který generuje pulzy v souladu s otáčkami pravého kola. 
12. Stavová LED kontrolka motoru na levé straně: signalizuje otáčky motoru vpřed, resp. vzad. 
13. Stavová LED kontrolka motoru na pravé straně: signalizuje otáčky motoru vpřed, resp. vzad. 
14. Konektor pro připojení přídavné desky, na které může být nainstalován například bezdrátový 

modul APC220, nebo Snake Vision (rozpoznávání rozdílů teploty). 
15. Stavová LED kontrolka pro komunikační rozhraní RS232. 
16. Stavová LED kontrolka 2: volně přístupná kontrolka pro programování. 
17. Stavová LED kontrolka pro přenos dat přes USB. 
18. Ovladač motoru. 
 
Základní informace k AAR 
V přední části se nachází USB rozhraní, které je vybaveno integrovaným obvodem s převodníkem 
FT232.  Čip převádí USB signál na signál UART RS232, který pak může procesor ATmega328P 
zpracovat (procesor je uložen na pravé straně přední části). 
Na opačné straně je umístěn přepínač ON/OFF s konektorem JP3 pro připojení napájení a ovladač 
motoru IC2. Pro umístění obou motorů a senzorů kol bylo vybráno místo na zadní straně desky 
plošných spojů (DPS). 
Senzory kol využívají fotografické oči. V ozubených kolech jsou čtyři otvory umístěny v úhlu 90º. 
Jakmile do otvoru pronikne světlo a dopadne na senzor, senzor vyšle spouštěcí signál příslušného 
kola do procesoru a elektronický obvod zapne LED16, resp. LED17. Spouštěcí pulzy nám umožňují 
získat přesný přehled o rychlosti každého ze zadních kol. 
Přední část je osazena konektory pro přídavné desky a na spodní straně DPS najdeme senzory 
obvodu pro sledování čáry. 
Modul pro sledování čáry využívá světelný paprsek z LED, který směruje do spodního prostoru. Podél 
LED jsou umístěny dva infračervené senzory, které sledují odraz světla ze spodní strany. DPS navíc 
nabízí další komponenty pro zkompletování sledovače čáry jako funkčního modulu (diody, rezistory            
a kondenzátory). 
Robot používá desku Arduino, kterou lze porovnat s deskou Arduino Duemilanove. Jádrem systému je 
mikrokontrolér ATMEGA328P, který nabízí 14 digitálních vstupů/výstupů, z nichž šest lze nastavit jako 
výstupní kanály PWM (kanály pulzně šířkové modulace). Kromě toho je robot vybaven šesti 
analogovými vstupními kanály, krystalovým oscilátorem 16 MHz a USB konektorem pro programování 
a ovládání. Seznam ukončuje ISP konektor, který umožňuje zkušeným nadšencům programovat 
vlastní program boot-loader. 
Robot je napájen proudem s napětím 5 V a může mu postačovat napájení proudem z USB konektoru. 
Tato možnost je celkem pohodlná při programování a testování. 
Příjemné na tomto robotické systému jsou zdířky konektorů, které vám umožňují vkládat vlastní 
rozšiřující moduly, nebo přídavné moduly AREXX modelové řady ASURO. 
 
Základní informace k softwaru ARDUINO 
Software Arduino patří do kategorie volně dostupných programů a je univerzálně dostupný                      
pro každého včetně zdrojových kódů programovací platformy. 
Programovací platforma Arduino zahrnuje textový editor, okno zpráv a textovou konzoli. Lze přes ni 
komunikovat přímo s AAR a snadno tak přenášet programy přímo na procesor. 
Programům, které jsou napsány v jazyku Arduino říkáme sketch (projekt). Pro vytvoření a editaci 
těchto programů se používá normální textový editor. Soubory "sketch" se ukládají na pevném disku 
počítače a lze je identifikovat podle koncovky ".ino". 

Ukládání souborů sketch je oznamováno v okně zpráv, kde se objevuje i informace o případných 
chybách v zdrojovém kódu. V pravé spodní části okna se zobrazuje aktivní deska Arduino a sériové 
rozhraní. 
Základní koncept Arduino nám poskytuje knihovny s extra funkcemi. Knihovna obsahuje mnoho 
předdefinovaných funkcí, které lze bezplatně použít k opakovanému programování sekcí. 
 
V zásadě lze program Arduino rozdělit do tří částí: 
1. Struktura 
2. Definice (proměnných, resp. konstant) 
3. Funkce 
 
Struktura Arduino se skládá z nastavení a funkce smyčky. Nastavení se používá pro inicializaci 
proměnných, definici pinů ("Pin režimů") a definici knihoven. 
Funkce smyčky se bude opakovat v nekonečném cyklu a umožňuje tak programu nepřetržitě do 
nekonečna reagovat, až dokud se systém nevypne. 
Definice proměnných se v programu používají pro ukládání a práci s daty programu, které lze 
upravovat, zatímco konstanty se používají pro definice pevných hodnot, jako jsou definice funkcí pinů 
pro vstup, nebo výstup a určení pevných úrovní napětí na pin konektorech. 
 

Začínáme 
 
Stáhnutí a instalace programu Arduino 
Nainstalujte si software Arduino (verzi 1) z přiloženého CD. Později můžete navštívit webové stránky 
Arduino a stáhnout si z nich nejnovější verzi softwaru. 
 
Důležité: 
Používání různých verzí programu ARDUINO a různých verzí softwaru aplikace může způsobovat 
určité problémy. Někdy se může stát, že po aktualizaci softwaru ARDUINO budete muset upravit 
aplikační software, protože jinak nebude pracovat! 
 
Jazyk Arduino  
Gramatika jazyku Arduino je zadokumentována na oficiálních webových stránkách Arduino. Naučte se 
porozumět specifickým znaků jazyka do té míry, která bude vyhovovat vašim potřebám. 
 
Instalace USB ovlada če 
Když připojíte desku, měly by Windows zahájit instalaci ovladače (Pokud jste už dříve nepoužívali PC 
s připojenou deskou Arduino). Pod Windows Vista a novějšími verzemi operačního systému se 
ovladač stáhne a nainstaluje automaticky. 
V menu Tools > Serial Port vyberte sériové zařízení desky Arduino. Mělo by to být COM3 nebo vyšší 
(COM1 a COM2 jsou obvykle vyhrazeny pro sériové porty hardwaru). 
Zjistíte to, když odpojíte desku Arduino a znovu otevřete menu; položka, která se ztratila, by měla být 
deska Arduino. Desku znovu připojte a zvolte sériový port. 
 
Hardware AAR 
 
Instalace baterií 
Robot je konstruován pro napájení čtyřmi bateriovými články 1,5 V, velikost AAA. Pokud chcete 
napájet robota nabíjecími akumulátory, měla by se nainstalovat jako přemostění propojka JP4, aby se 
systém připravil na nižší napětí nabíjecích akumulátorů (viz obr. 1, číslo 4). 
 
POZOR! 
Instalací propojky JP4 se znemožní kontrola polarit y pomocí usm ěrňovací diody. Chyby                   
v elektrickém p řipojení s nainstalovanou propojkou JP4 mohou robota  vážně poškodit.  
 
Připojte schránku s bateriemi, jak ukazuje obrázek 2. 
 



 
Obr. 2: P řipojení baterií  
 
Nyní můžete přepínačem ON/OFF robota zapnout. Rozsvítí se LED kontrolka napájení (LED5),  
která je umístěna hned vedle přepínače. 
 
Software Arduino 
 
Programování robota pomocí program ů Arduino 
Připojte robota pomocí USB kabelu k PC. 
Jakmile se robot připojí k USB portu, systém Arduino nebude v postatě potřebovat jiný zdroj napájení, 
tj. napájení bateriemi není potřebné. Požadovaný proud bude poskytovat USB konektor počítače. 
 
POZOR: 
Jakmile se systém p řipojí k PC, robot se vždy aktivuje. P řepínač ON/OFF a LED5 se aktivují jen 
v případě napájení bateriemi. 
Nyní můžete otevřít program Arduino(viz obr. 3 a). 
 

 
Obr. 3a: Software Arduino    Obr. 3b: Otev ření programu Blink  
 
Výběr programu Arduino 
Začneme tím, že načteme do robota jednoduchý ukázkový program s názvem "blink".  
Program přikáže robotovi opakovaně rozsvítit LED1. 
Program načteme kliknutím v menu na File > Examples > 1. Basics > Blink (viz obr. 3b), po čemž  
se okně platformy zobrazí následující zpráva (obr. 4a). 
 

 
Obr. 4a: Program Blink     Obr. 4b: Zvolte Board  
 
V tomto kroku budeme muset vybrat správnou desku Arduino pod položkou menu Tools > Board >  
Arduino Duemilanove nebo Nano w/Atmega328 (viz obr.4b). 
 
Výběr Comport 
V dalším kroku definujeme správný sériový port pro rozhraní Arduino. Správné sériové rozhraní  
(nebo COM port) robota je COM 12. 
Výběr COM rozhraní provedeme pod položkou menu Tools > Serial Port > COM 12 (viz obr 5). 
 

 
Obr. 5: Výb ěr správného Com-portu 
 
Přenos programu z PC na robota Arduino 
Klikněte prosím na tlačítko, které je na obrázku označeno červenou šipkou (nebo pokračujte přes 
položku menu "File > Uploading to I/O board"), aby se zvolený program přenesl na připojeného robota 
Arduino (viz obr. 6a). 
Stavové okno hlásí proces kompilace, a jakmile se kompilace úspěšně dokončí, systém začne  
s přenosem programu na robota. 
Po dokončení přenosu stavové okno ohlásí jeho dokončení zprávou: "Done uploading" (viz obr. 6b). 
 



 
Obr. 6a: P řenos programu   Obr. 6b: P řenos programu dokon čen 
 
Nyní můžete odstranit USB kabel a odpojit robota od PC, připojit pouzdro s bateriemi, nebo napájení  
a zapnout robota. 
Pro další informace a soubory ke stažení navštivte fórum na jedné ze stránek: 
www.arexx.com >  Forum  
www.roboternetz.de > Forum 
 

Základní informace k obvodům H - můstku 
 
H můstek je elektronický obvod, který umožňuje obrátit polaritu zařízení (jako např. DC motor) pomocí 
čtyř přepínačů. H můstky se v robotice často používají pro ovládání otáček motoru v opačných 
směrech. 
V moderních systémech se k ovládání motoru sice používají integrované obvody, ale pro pochopení 
základů a rozměru problémů spojených s napájecími zdroji může být důležité prostudovat si archaický 
obvod ovládání motoru. 
 
H můstek pro 3 V napájecí zdroje 
Řídící obvod Hyper-Peppy robotů obsahuje dva tranzistory TR7 a TR8, respektive NPN tranzistory 
TR9 a TR10. V našem schématu může být proud veden zároveň do motoru M vždy jen dvěma 
tranzistory: 
Přes TR7 a TR10, nebo 
Přes TR8 a TR9. 
Volně dostupná testovací verze programu Micro Cap nám umožňuje pohodlně propočítat simulaci DC 
a přečíst si hodnoty v okně schématu: 
 

 
Obr. 8: Simulace H m ůstku v robotovi Hyper Peppy 

 
V řídící části můžeme vidět DC motor M. Předzesilovač řídícího obvodu je simulován rezistorem R14, 
který drží základní porty tranzistorů TR6 a TR5 na 0V, což má za následek, že signifikantní proud  
je veden jen pravou větví. 
Proud prochází tranzistory TR8, TR5 a TR9, zatímco ostatní tranzistory jsou blokovány. Jakmile se 
přepínač R14 přepne na kladné napětí, pravá větev se zablokuje a proud v motoru se obrátí. 
Simulátor Micro Cap nám umožňuje vypočítat proudy pro všechny komponenty a přečíst si hodnoty  
v okně schématu. Celkový napájecí proud v případě baterií s napětím 3 V bude kolem 300 mA. 
Pozoruhodně nízké napájecí napětí obvodu je založeno na kombinaci křemíkových PNP a NPN 
tranzistorů, které pracují s napětím 0,7 V. Motor je osazen mezi dva porty kolektorů, které v ideálním 
případě zaznamenávají pokles napětí jen 0,3 V. V praxi tak pro motor zůstává slušná hodnota 1,5 V. 
Hodnoty vypočteny programem Micro Cap, vidíte na obrázku 9. 
 

 
Obr. 9: Nastavení DC pro H m ůstek u robota Hyper Peppy 
 
Ideální řešení pro robota představuje napájecí zdroj 3 V, který tvoří jen 2 bateriové články. PNP 
tranzistory lze nicméně do integrovaného obvodu, jakým je L293D zakomponovat jen poměrně složitě. 
Integrovaný obvod má však jiné výhody, jako je spolehlivost, ochranné diody, které chrání tranzistory 
před poškozením a zmenšená plocha DPS související s nízkou hmotností. Proto jsme se rozhodli 
použít čip L293D, v kterém jsou dva H-můstky pro ovládání dvou DC motorů. 
 
H-můstek pro nap ětí 4,5 V 
Čip L293D (viz obr. 10) nám umožňuje regulovat výstupní proud až 600 mA na kanál (max. proud ve 
špičce: 1,2 A). Napájecí napětí ovladačů (VCC2) může být v rozsahu mezi 4,5 V až 36 V, což dělá z 
čipu L293D oblíbený obvod pro ovládání DC motoru. 
Protože minimální napájecí napětí (VCC2) je stanoveno na 4,5 V, jsme nuceni zvolit jako zdroj 
napájení minimálně 4 nabíjecí akumulátory. Touto investicí se zvyšuje celková hmotnost robota, což je 
cena za moderní elektronický obvod. 

 
Obr. 10: H-m ůstek s integrovaným obvodem L293D 



Odometrie 
 
Tato část je věnována několika zajímavým aplikačním konceptům robota AAR. Nápady vycházejí ze 
studií a vývoj takového softwaru nás může inspirovat při programování mikrokontroléru. 
 
Sledova če čáry, reakce na sv ětlo a barvu 
Senzory citlivé na světlo nám umožňují naprogramovat robota, aby se choval jako sledovač čáry, nebo 
aby reagoval na barvu. V prvním z příkladů se od robota očekává, že bude sledovat 8 hrannou křivku, 
která ho přinutí pohybovat se stále dokola v nekonečné smyčce. 
Druhý a třetí příklad naučí robota, aby se vyhnul zdroji červeného světla a aby ho zároveň přitahovalo 
zelené světlo. Tento druh vzorců chování je již možné považovat za praktické vzorce pro přežití  
u jednoduchých živých organismů, jako jsou červi. 
 
Reakce na zvuk 
Celkem zajímavé jsou i vzorce chování, podle kterých robot reaguje na zvuky v okolí. Nervózního 
robota, který je vybaven citlivým mikrofonem, můžeme naučit, aby se vyhýbal tvrdé basové hudbě a 
zároveň aby jej přitahovaly vysoké tóny flétny. Přitažlivost vysokých frekvencí může dokonce převýšit 
strach z velmi nízkých frekvencí. Robot tak může být přinucen, aby ho přitahoval zdroj zvuku flétny i 
přesto, že vnímá zároveň tvrdou metalovou hudbu. 
Vzorce chování, která závisí na vysokých a nízkých frekvencích, na světle a barvách vyžadují pouze 
několik senzorů, dva frekvenční filtry a pár senzorů reagujících na světlo vybavených barevnými filtry. 
 
Komplexní sledování čáry  
Pro vyhledávání a sledování čáry roboti obvykle potřebují světelný zdroj, jakým je LED a dva, nebo 
více světelných senzorů. Tyto zařízení dovolují systému identifikovat čáru a sledovat trasu. Je možné, 
že ze začátku bude robot potřebovat speciální vyhledávací vzorec, aby si vypěstoval návyk pro 
vyhledání čáry. Tento vzorec se může skládat ze strategie pro sledování spirálového vzoru, jehož 
poloměr se postupně od startu zvyšuje. Robot má sledovat daný vzorec, až dokud senzor nezachytí 
jiný vzorec čáry a nezačne sledovat tuto čáru. 
Vývoj takovýchto programů dostatečně řeší problém vyhledávání jakýchkoliv vzorců čar a patří už do 
kategorie sofistikovaných programů. 
 
Komplexní vzorce chování  (jako úloha programování)  
Projekt může být zkomplikován zadáním vyhledávací strategie, s kterou se má pracovat  
v komplikovaných vzorcích barevných oblastí a čar, aby se našla nějaká červená čára, která přivede 
robota do bezpečné tmavé "garáže". 
Jakmile se na chvilku ztratí vzorec hluku, robot může opustit svoji "garáž" a začít hledat zelenou čáru, 
která ho může dovést do jiné "garáže" s jasným zeleným světlem, kde se bude robot cítit spokojeně,  
a to i v prostředí s tvrdou rockovou hudbou. 
Jakmile však robot zachytí vysoké frekvence flétny, začne se cítit nepříjemně. Opustí své stanoviště, 
aby našel červenou čáru, která ho přivede zpět domů, do tmavé "garáže". 
Zkušení programátoři si uvědomují složitost a požadavky na design programu, který má sloužit pro 
řešení problémů sledování čáry spojených s několika různými závislostmi na barvě a zvuku. 
Programátor bude muset navrhnout program s hierarchickou sadou mnoha funkcí. Komplexní, ale 
spolehlivý software, který bude vykonávat specifický úkol, nám umožní napsat jen dobře strukturovaný 
koncept sestávající s několika modulů. 
Komplexnost softwaru může vzbuzovat u programátorů obdiv k všem drobným živým organizmům, 
které kombinují tyto vzorce chování v strategii pro pravidelné vyhledávání potravy a rozmnožování. Je 
to ohromné úsilí života přírody znova a znova zdokonalovat vzorce chování a zachovat existenci 
života… 
 
 
 
 
 
 
 
 
 

Programování programu bootloader 
 
Pozor! 
Níže popsaný návod vyžaduje zkušenost v programován í! 
 
Bootloader pro Arduino můžete načíst na mikrokontrolér například pomocí STK500. K tomu, abyste 
mohli jakýkoliv program napsaný v jazyku Arduino přenést na mikrokontrolér Atmega, musí být 
procesor Atmega vybaven speciálním bootloaderem Arduino. Tento program bude potřebný k tomu, 
aby se správně lokalizovaly kódové znaky v paměti Atmega. 
K instalaci programu bootloader budeme potřebovat následující komponenty: 
• Vývojovou desku AVR (například desku STK500) 
• 12 V napájecí zdroj 
• Robota AAR včetně konektoru ISP zasazeného na desce (obr. 7) 
• Počítač vybavený fyzickým Com portem (nejlépe bez konvertoru USB-RS232, který může mít  

za následek riziko chyb časování). 
 
Nainstalujte si prosím (respektive aktualizujte) poslední verzi softwaru Arduino, kterou najdete na 
stránkách www.arduino.cc. Soubor bude ke stažení zřejmě v zkomprimovaném formátu. ZIP, nebo 
RAR. Rozbalte soubor a jeho obsah si uložte na pevný disk. 
Pro přenos programu Arduino bootloader na robota použijte WINAVR. 
 
Pozor!  
Software Arduino patří do kategorie volně dostupných programů a z času na čas se může stát,  
že software Arduino nemusí s programem bootloader pro Arduino spolupracovat! 
Pokud se setkáte s takovým problémem, navštivte příslušné fórum na některé ze stránek věnovaných 
problematice Arduino. 
 

 
Obr. 7: Konektor ISP  
 
 

Technické údaje 
 
Motory: 2 motory 3 V DC 
Typ procesoru: ATmega328P 
Programovací jazyk: ARDUINO 
Napájecí napětí: 4 x baterie typu AAA, 4,8 - 6 V 
Napájecí proud: Min. 10 mA - max. 600 mA 
Komunikace: USB konektor 
Rozšíření: Kompatibilní s ASURO 
Výška: 40 mm 
Šířka: 120 mm 
Hloubka: 180 mm 
 
 
 
 
 
 
 
 
 
 
 



Recyklace 
 

Elektronické a elektrické produkty nesmějí být vhazovány do domovních odpadů.  
Likviduje odpad na konci doby životnosti výrobku přiměřeně podle platných  
zákonných ustanovení. 
 

Šetřete životní prost ředí! Přisp ějte k jeho ochran ě! 
 

Manipulace s bateriemi a akumulátory 
 

 
 

 

 
Nenechávejte baterie (akumulátory) volně ležet. Hrozí nebezpečí,  
že by je mohly spolknout děti nebo domácí zvířata! V případě spolknutí baterií 
vyhledejte okamžitě lékaře! Baterie (akumulátory) nepatří do rukou malých 
dětí! Vyteklé nebo jinak poškozené baterie mohou způsobit poleptání pokožky. 
V takovémto případě použijte vhodné ochranné rukavice!  
Dejte pozor nato, že baterie nesmějí být zkratovány, odhazovány  
do ohně nebo nabíjeny! V takovýchto případech hrozí nebezpečí exploze! 
Nabíjet můžete pouze akumulátory. 
 

 

 
 

 

 

Vybité baterie (již nepoužitelné akumulátory) jsou zvláštním odpadem  
a nepatří do domovního odpadu a musí být s nimi zacházeno tak,  
aby nedocházelo k poškození životního prostředí!  

K těmto účelům (k jejich likvidaci) slouží speciální sběrné nádoby  
v prodejnách s elektrospotřebiči nebo ve sběrných surovinách! 
 

Šetřete životní prost ředí! 

 
Záruka 
Na programovatelného robota Arduino Arexx AAR-04 poskytujeme záruku 24 m ěsíců. 
Záruka se nevztahuje na škody, které vyplývají z neodborného zacházení, nehody, běžného 
opotřebení, nedodržení návodu k obsluze nebo změn na výrobku, provedených třetí osobou. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Přílohy 
 
Seznam komponentů 
 
Část     Hodnota  Balení 

 
 
 
 
 
 
 
 
 
 
 
 
 



Část     Hodnota  Balení 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A. Hlavní DPS (pohled seshora) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



B. Hlavní DPS (pohled zespodu) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

C. Obvod AAR 
 

 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 

Překlad tohoto návodu zajistila spole čnost Conrad Electronic  Česká republika, s. r. o. 
 

Všechna práva vyhrazena. Jakékoliv druhy kopií tohoto návodu, jako např. fotokopie,  jsou předmětem souhlasu společnosti  
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